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Topics

► Introduction

► eDiscovery Primer
► Overview of eDiscovery process
► Key risks and highlights from significant cases
► Revised Federal Rules of Civil Procedure summary

► Strategies to reduce risk & cost
► Top concerns of companies 
► Common pitfalls and how to avoid them
► Leading practices for developing a response plan for eDiscovery

► Question & answer
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Dilbert on eDiscovery 
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In the beginning, there was Paper

► 93% of all information created during 1999 was in digital form.
University of California.

► By 2013 IM will be used by 95 percent of employees as their de facto 
communications tool for voice, video and text. Gartner Group

► Americans send 2.2 billion e-mail messages a day. Gartner Group

► The typical company stores more than 50% of their business 
records and information in electronic format. Pricewaterhouse Coopers

► 15.8 MB of email sent/received per user each day by 2008. Email 
Discovery: Tape Is Not Enough, iLumin Software Services
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eDiscovery Challenges & Issues

Today, 80 percent of a company’s 
information is unstructured data. (Gartner)

Unstructured data
(e-mail, Word docs,

presentations,
rich media, etc.)

Structured
data

(enterprise databases,
GL, etc.)
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Business Risk Events

► Regulatory Inquiry/Audit
► Investigation
► Laptop theft
► Data migration
► Customer/employee Fraud
► Customer/employee Complaint
► Privacy breach
► Natural or man-made disaster
► Litigation
► Insurance claim
► Dispute
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Discovery in the legal process

“Company A sues Company B”

Both sides (plaintiff and defendant) are required to turn over 
relevant materials pertaining to the case, outside of privileged

material.

This means all letters, memos, documents and emails pertaining 
to the case must be shared with each side.
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What is Discovery?

► The process of identifying, preserving, collecting and 
producing information that may be used as evidence in a 
legal proceeding

► Information exchanged through discovery is subject to 
review and analysis

► The most common instruments of discovery are:
► Interrogatories
► Requests for production
► Depositions

► While discovery is a civil litigation term, the basic 
processes of discovery (identification, preservation, 
collection, review and analysis) also apply to 
investigations and audits
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What is ESI? (Electronically Stored Information)

► Information that is stored in a medium from which 
it can be retrieved and examined…from 
"reasonably accessible“ sources

Federal Rules of Civil Procedure
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Sources of Electronic Evidence

Desktop/Laptop Computers Servers
• Public Shares
• Private Shares
• Financial System
• Customer Data
• Employee Data

Portable Media
BlackBerry/PDA
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► Informal forms of electronic communications

Instant messaging
• Public (Yahoo, AOL)
• Corporate (Lotus)

Virtual workrooms
Bulletin boards
• Public (Yahoo)
• Private (Intranet)
Chat rooms

Voice-mail

Sources of Electronic Evidence
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eDiscovery challenges

► Higher degree of complexity than traditional discovery
– Ease of duplication
– Ease of dissemination
– Backups
– Portability
– Volume

► Identification, preservation and collection are difficult

► Collection, review and production are expensive
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General Counsel Priorities

According to 
GC Roundtable 
Research…

►Understand the universe of potentially 
responsive evidence

►Effective management of the collection and 
preservation process

►Minimize disruption to business and 
revenue generating employees

►Reduce the cost of eDiscovery
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Issues

The courts are 
raising the 
bar…

►US Courts/ Regulators reaching globally

►Higher expectations to provide evidence

►Shorter period of time to respond legal notice

►Courts assume rational and effective internal 
controls  

►Courts imposing sanctions for late production -
missing records - incomplete responses
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Qualcomm Inc. v. Broadcom Corp. 

► Patent infringement case 
► Qualcomm had more than 46,000 e-mails responsive to the 

discovery requests that it failed to produce
► Consequences for eDiscovery failure

Qualcomm ordered to pay Broadcom +$8.5 million in attorneys’ fees 

Qualcomm’s attorneys referred to State Bar of California for an 
investigation of ethical violations.



Page 17

Emerging Issues

Privacy ►International Privacy laws

►Safeharbor, Data Protection Contracts, 
Binding Corporate Rules for exceptions to 
data privacy requirements

►Definition of “personal data” varies by country
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Emerging Issues

Global View ►Different Languages/Cultures

►IT outsourced across the globe

►Cross-border data flow
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Electronic discovery reference model
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Revised federal rules of civil procedure: 
overview
► 16(b): Parties have 120 days from date of complaint to provide plan for 

e-discovery and production at scheduling conference

► 16(b)(5): Court can include E-Discovery agreement in scheduling order

► Rule 26(a)(1)(B):  Mandatory disclosure re categories and locations of 
electronic information

► Rule 26(b)(2)(B):  Standard of “reasonably accessible;” cost and burden 
considerations; cost-shifting

► Rule 26(b)(5)(B):  Inadvertent production (“claw-back”)

► 26(f): Parties must meet 21 days before scheduling conference to discuss 
e-discovery process and agree on protocol

► Rule 34:  Form of production (“ordinarily maintained” or “reasonably 
usable”)
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What is a Legal Hold?

► A communication suspending the normal disposition or 
processing of records

► Issued in connection with:
► Litigation (or reasonable anticipation thereof)
► Regulatory and internal investigations
► Third-party subpoenas
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Legal Hold Challenges

► Suspension of deletions overwhelms computer systems

► Frequently no formal procedures to communicate,  
implement and document the Hold Order

► Legacy data and systems often represent real challenges

► Multiple overlapping Legal Holds may apply to documents 
and disposition must wait for all relevant Holds to lift
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The Electronic Discovery Process

►Define the criteria that 
“trigger” the need to 
preserve electronically 
stored information

►Process to Scope:  
people, data sources, 
dates, retrospective, 
prospective, etc. 

►Notify stakeholders

►Compliance monitoring

►Tracking System

►Determine method(s) of 
preservation and criteria 
for decision making

►Systems inventory and 
routine preservation / 
destruction schedules

►Frequency of preservation

►Preservation Notice

►User Response 

► IT Responses

►Vendor Responses

►Strategy to identify scope 
& disclose issues 

►Compliance monitoring

►Tracking System

► In-house

►Outside counsel

►Third-party

►Standardized 
protocols:
►Processing for 

review
►Privilege Review
►Culling (keyword, 

intelligent search)
►Technology
►De-Duplication

►Quality Control 

►Determine method(s) of 
collection and criteria for 
decision making 

►Collection Notice
►Define scope
►Communicate
►Track

►Processes for collection:
►User Collection
► IT Collection
►Outsourced   

collection

►Supporting Technology

►Strategy to disclose 
collection process & 
issues

►Standardized protocol:
►Format
►Technology
►Tracking
► In-house role
►Outside counsel 

role

►Position related to pre-
privilege review:  “quick 
peek” and “clawback”
agreements

►Quality Control

Notice or 
Subpoena Preserve ProduceCollect Review

The electronic discovery process and associated tasks.
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eDiscovery: What Can Go Wrong

► No preservation notice

► Exclusion of admin assistants of top execs as custodians

► No changes of IT procedures to comply w/ preservation order

► Non-forensic collection of data

► Focus on eMail only – insufficient collection of other media

► No consideration of backup tapes

► Comingling of eMail and other data types on backup tape 
media 
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Benefits of a Discovery Response Program

► Understand the universe of data

► Timely, effective preservation and collection

► Minimize disruption to employees

► Reduce cost without increasing risk

► Reduce document review fees

► Reduce risk of sanctions
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Discovery Response Program – People Insights

Solutions

►Take back responsibility for 
electronic discovery

►Create a Discovery Response 
Team comprised of IT, Business, 
and Legal

►Establish a Discovery Liaison 

► Identify and prepare witnesses to 
testify regarding Discovery 
Response Program and systems

Challenges

► Legal lacks understanding 
of IT limitations

► IT lacks understanding of 
Legal’s discovery 
obligations and risks of 
evidence destruction

► No central coordinator of 
discovery requests
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eDiscovery Project Stake Holders
Leading Practices

Program Sponsors
CCO - GC - CIO

Global Network

Steering Board
Chief Compliance Officer
IT Service Management

IT Sourcing, IT Compliance, IT Finance
Legal –Deputy General Counsel

External Counsel
Records Management

External CounselGlobal IT Compliance
Network

Global Implementation Teams Outsourcing Project Team Implementation Support Team

Global IT Audit Network

IT Compliance Team

Global Legal Network

Must include: 
► Legal
► Records Management
► Compliance
► Business Units
► IT

► Enterprise Apps
► Email
► Desktop Support
► Outsourced 

► Program Management
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Discovery Response Program – Process Insights

Solutions

► Prioritize business lines with high 
discovery risk

► Develop a data preservation plan 

► Procedures to communicate and 
monitor the success of the 
preservation plan

► Establish standard process for 
collection and review

► Define production protocol

► Uniform approach for records 
management

Challenges

►Legal Holds preserve too 
much or too little

►Lack of a coordinated 
Discovery Response plan

►Lack of training and 
monitoring on preservation 
procedures

► Inadequate Records 
Management infrastructure 
and policies
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Discovery Response Program  – Technology Insights

Solutions

► Program to respond to global 
scope of preservation orders

► Centralized electronic 
information repositories

► Identify data sources  at risk of 
discovery

► Evaluate ability of systems to 
support discovery

► Develop standard response to 
data interrogatories

Challenges

► Inconsistent internal 
response to discovery 
requests

► Inadequate electronic 
information inventory

►No plan for preserving and 
collecting emerging data 
sources 

►Difficulty retrieving data from 
obsolete systems or media
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What is an ESI map?

► An overview of “electronically stored information” that 
exists within the enterprise

► High-level or very detailed
► Includes information outside of retention schedules

► For use in “meet & confer” discovery planning discussions
► Provides a high-level overview of potentially relevant systems and 

data to meet F.R.C.P. disclosure obligations
► May be used by outside counsel and excerpts may be provided to 

parties in litigation
► Identifies retrieval cost & burden to produce “Not Reasonably 

Accessible” sources
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What can be achieved with an ESI map?

► Risk reduction
► Know what information you have and don’t have – Prevent sanctions 

as a result of overlooked data sources
► Identify “excess” data that is not needed for business or regulatory 

requirements

► Cost reduction
► Reduce the cycle time to identify and preserve potentially relevant ESI
► Identify ‘go-to’ sources of ESI (e.g., system of record) and exclude 

redundant data sources
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Approach to developing an ESI map

Confirm the design of the map with key stakeholders, then 
populate the map through interviews and/or surveys with 
legal, IT and business users.  Develop a process to 
update and enhance the map.

Design Populate Enhance
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Approach to developing an ESI map

► ‘Class A’ sources
► ESI sources most often requested and determined to be relevant
► Many attributes collected such as owner, location, date range, volume, 

summary description, and analysis for “not reasonably accessible”
sources

► ‘Class B’ sources
► ESI sources that may be discussed during discovery planning 

discussions, but unlikely to be produced
► Limited number of attributes collected such as owner and location

‘Class C’ sources
► Sources of ESI that would not be requested or produced (e.g., SMTP 

server)
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Integrate the ESI map into your processes 

Establish roles and responsibilities for key processes. 

AIIIAIGeneral Counsel

IA/RICCIOutside Counsel

RCAARIDiscovery Coordinator

RRRecords Manager

RRIT Manager

R

6

R

432

CVendor A, B, C

51Roles

Trigger
Event

Initiate
Hold

Collect
ESI

Process
& Load Review Produce

1 2 3 4 5 6

RResponsible

AAccountable

CConsult

IInform

Legend
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ESI Mapping Summary

► Confirm design with key stakeholders, prepare prototype
► Focus efforts on ‘Class A’ sources
► Confirm completeness and accuracy of map with legal, IT and 

business personnel
► Develop means for updates and enhancements to map
► Integrate ESI map into discovery, records management and 

information governance processes
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Contact Details

Heidi Stenberg
Ernst & Young
Senior Manager
Fraud Investigation & Dispute Services
heidi.stenberg@ey.com
Chicago, IL 
(312) 879-2162



Thank You


